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TYPO3 Content Management 
Introduction 
TYPO3 gives you the ability to keep your area (workspace) of the MCC website up to date, as 
easily as any other documents you might work with on a regular basis. It also allows for a 
designated workflow and content approval cycle that minimizes the chance of publishing 
inaccurate information to the live website. The first part of this editing guide outlines the steps 
for updating content as a Basic Editor, within an assigned workspace. The Publisher’s role in 
particular in the TYPO3 workflow is discussed on page 23 of this document. 

Logging in 
To begin editing in TYPO3 from a computer on campus (as pictured in Figure 1) 

1. Open www.monroecc.edu/typo3 in the Chrome browser*. Be sure to allow all popups 
from this site! 

2. Type your MCC username (your full MCC email address) and password. 
3. Click the login button. 

 
Figure 1  
To begin editing TYPO3 from a computer off-campus, you must first log in to the MCC VPN. 
The instructions can be found in the Employee tab in MyMCC. Go to: 

1. Technology Links 
2. Access from Home 
3. Follow the instructions for Remote Desktop Via VPN (AnyConnect). 

https://www.monroecc.edu/typo3
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*Important: Using the Firefox or Internet Explorer browsers to work within the TYPO3 
backend will produce undesirable results. 

Selecting your Workspace for editing 
The first time you log in, the page will open to the first workspace you were granted 
permissions to edit.  After your very first login, TYPO3 will remember the last workspace that 
you were editing in. If you have editing permissions to more than one workspace, you can 
access them by clicking on the workspace icon in the header bar (as pictured in Figure 2). 
Note:  You should be on PAGE in Module menu (as pictured in Figure 2a). 

 Figure 2 

 Figure 2a  

To change to another workspace, click on the desired workspace name.  The selected 
workspace will get the checkmark and the workspace name will appear after your username 
(as pictured in Figure 3). 

  
Figure 3  
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Working with Content Elements 
TYPO3 pages consist of one or more Content Elements or Content Blocks. To edit a page, 
you work within the individual content elements. 

Remember: Don’t be confused by all the icons. To find out what an action icon does, use 
the mouse to point and hover (do not click) over any icon to see the help text appear. 

1. Pass the cursor over the top bar of a content element until the four-pointed arrow 
appears 

2. Click on the pencil icon to open the element for editing. 
3. Clicking on the text of the element will do the same thing, open the element. 

4. Clicking on the copy element icon will copy the entire content element and allow 
you to paste it on the same page or another page (as pictured in Figure 4). 

 Figure 4  
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Working in the Editing Window 
The top of the editing window contains the settings for the content element. For day to day 
editing purposes, you probably won’t be changing the defaults. 
There are three main types of content elements that you will use: Text, Text & Images, and 
Images.  Different options for arranging images appear for the Text & Image and Image type 
of content elements (as pictured in Figure 5). 

  
Figure 5  

When creating a new content element, the Header can be used as a short title. You can also 
1) add a date and 2) make it a hyperlink (as pictured in Figure 6). 

 
Figure 6  
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Accessibility Note: If you give the content element a visible header, 
remember that in order to follow ADA accessibility rules for content on a page, 
headings must follow the H1 to H5 protocol. The only H1 on a web page would 
be the page heading. Content elements below that must cascade down from 
h2, according to the relationship of one to the next (as pictured in Figure 7). 

  
Figure 7  

The toolbar gives you two options for many functions. 
You can use (1) drop-down menus or (2) icons (as pictured in Figure 8). 

 
Figure 8  

You can use full-screen editing or adjust the screen size for editing using the control at the 
bottom right of the text window (as pictured in Figure 9). 

 
Figure 9  

Editing a content block is similar to editing in Microsoft Word. You will notice that the functional 
icons in the Rich Text Editor are the same or very similar to Microsoft Word. 
Be sparing when using italics, bold and other type features. Try to avoid using terms that 
someone you met on the street would not be familiar with. 

*Be sure to use the spell checker once you are done editing . 
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TYPO3 does not automatically save your changes! 
Whenever you make changes to content in TYPO3, be sure to look for the icons at the top of 
the editing window and click at least one of them (as pictured in Figure 10): 

  
Figure 10  

1. Save document 
2. Save document and view page* 

You need to use this option when you are done to move this forward in publishing. 
3. Save and close document 
4. Save document and create a new one (content element on the same page) 

The remaining icon functions are: 
5. Close document 
6. Delete (content element) 
7. Shows record history of changes 
(as pictured in Figure 11) 

  
Figure 11  
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Pasting content from MS Word and other sources 
Pasting content from other sources is always a time and effort saver. However, often extra 
hidden formatting gets copied into the content element.  If you find you need to, you can 
remove formatting by selecting Clear Formatting from the drop-down menu under Format (as 
pictured in Figure 12). 

  
Figure 12  

The TinyMCE editor works like most text editors.  If you hit <enter>, you will get a hard 
carriage or paragraph return, which gives the appearance of a double space between lines. To 
get a soft carriage return or single-spacing when adding lines, use <shift><enter> (as pictured 
in Figure 13). 

 
Figure 13  

 Accessibility Note: Adding white space between paragraphs using 
double hard or soft carriage returns will decrease the accessibility of the 
content. The CSS/style sheet is set to provide consistent text line 
spacing between sentences and paragraphs.  
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Copy and Paste Functions 
While you can copy using right-click on your mouse, you will not be able to use your mouse to 
paste within TYPO3. The Paste option in the Edit drop-down menu also will not work. You will 
need to use Ctrl+V to paste (as pictured in Figure 14). 

  
Figure 14  

If by chance you forget, you will get a reminder to use the keyboard shortcut Ctrl+V to paste 
(as pictured in Figure 15). 

  
Figure 15  

Common Content Page 
Each department has a ‘common content’ page. This is where the information that appears on 
multiple pages (such as the contact information found in the right-hand column of department 
pages) is stored in separate content elements. 
These content elements are created on the common content page and then inserted as a 
“reference.”  If you see a blue information bar that states “This is a reference to an element on 
page….” you should find that content element on your common content page (as pictured in 
Figure 16). 
This allows you to edit the information once and have it display correctly on multiple pages. 

  
Figure 16  
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Adding Document and Image files to TYPO3 Workspaces 
TYPO3 editors have the ability to add document and image files to their workspaces. 
Documents should be saved in an easily accessible format, such as PDF*. 
Document filenames that will be uploaded and referenced on the web should: 

1. only include letters, numbers and hyphens 
2. be all in lowercase 
3. not include dates or version numbers 
4. not have spaces within the filename 

Uploading a file 
Before linking to a new document or adding an image file to a content element, it should be 
uploaded to your TYPO3 workspace in the documents or images filespace. Note: There are 
options to upload documents in conjunction with linking to the files. It is best to upload your 
documents/images first to ensure that you are placing them in the proper folders (as pictured in 
Figure 17). 

 
Figure 17  

Right-click on the folder icon to the left of documents or images in the page tree area. 
Click on Upload Files in the fly out menu (as pictured in Figure 18). 

  
Figure 18  
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If uploading a new version of a file— 
1. Select Overwrite existing files. 
2. Click the Choose Files button and find the file on your own hard drive, or any network 

area where you have access. 
3. Once the file is chosen, click Upload files. 

(as pictured in Figure 19) 

  
Figure 19  

The file name now appears in your workspace file list (as pictured in Figure 20). 

  
Figure 20  

You can also drag and drop files to the space above the Filename bar to upload them. 
Once you drag a file to that space, a message will appear (as pictured in Figure 21). 

  
Figure 21  

Remember - If uploading a new version of a file— make sure it has the same file name 
and select Overwrite existing files when prompted. 
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Creating PDF files 
*To convert files to PDF using Microsoft Word 2010 – select File > Save As and under… 

1. Save as type: select PDF. 
2. Before you save the file, select Options. 
3. Ensure that the Document structure tags for accessibility option is selected. 

(as pictured in Figure 22) 

 
Figure 22  

Accessibility Note: WebAIM.Org has detailed instructions for converting 
Word 10 documents, as well as other versions of MS Word to PDF 
documents.  

https://webaim.org/techniques/acrobat/converting#word
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Images 
Images should be optimized for Web presentation, including physical and file size, and file 
format. While TYPO3 has some built-in formatting tools, it is best that you contact the Web 
Services team if you are not familiar with these formatting requirements. 
Pictures shot with today's digital cameras are too large a file size to be placed on the web 
without editing. The Web Services team can assist you with these issues. 
Images on the web should have alt attributes so that assistive technology can describe the 
image and/or function of the image in a meaningful way. See WebAIM’s alt text page for 
additional guidelines on writing alternative text. 

TYPO3 Links 
The TYPO3 link icon is used to create links to pages, files, external URLs (other websites), 
and email addresses. The process is very similar for each type of link 
To begin creating each type of link Select the text that you want to link your file to and click on 
the TYPO3 Link icon (as pictured in Figure 23). 

  
Figure 23  

Accessibility Advice:  
• Avoid phrases like "Click here", "Here", "More", "More information", "Read more", and 

"Continue." 
• URLs as link text should usually be avoided unless the URL is relevant content. 

  

https://webaim.org/techniques/alttext
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Linking to a document 
Once you have uploaded a document file, the process of linking to it in the edit page view is 
quite straight forward. Click on the Page module, and then the item in the page tree that you 
wish to edit. Open a Content Element for editing (as pictured in Figure 24). (See Working with 
Content Elements, in the TYPO3 Editing Guide.) 

 
Figure 24  
Select the text that you want to link your file to and click on the TYPO3 Link icon (as pictured 
in Figure 23). 

1. Click on the File tab. 
2. Click documents in the Folder Tree. 
3. Click the down arrow to open the target menu and choose New window (as pictured in 

Figure26). This will open the document in a new browser window or tab when a user 
clicks on the link in the Web page. 

4. Type Opens PDF in new window in the Title field. 
5. Under Files: Click on the file name to choose that document. Save and switch to 

preview mode (see Previewing Pages) to test the link. 
(as pictured in Figure 25) 

  
Figure 25  
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Linking to another Page 
At times you may want to link to another page in the MCC website, such as directions to the 
College or another page within your own department. 
Once you are editing within a content element, select the text that you want to link your file to 
and click on the TYPO3 Link icon (as pictured in Figure 23). 

1. Click on the Page tab. 
2. If you are linking to a page outside your own department, click the down arrow to 

open the target menu and choose New window. This will open the page in a new 
browser window or tab when a user clicks on the link in the Web page. 

3. Type Opens internal link in new window in the Title field. 
4. Browse the page tree to reach the page you wish to link to and click on the page name. 

(as pictured in Figure 26) 
Save and switch to preview mode (see Previewing Pages) to test the link. 

  
Figure 26  
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When you link to a page within the same workspace: 

1. Choose the Page tab. 
2. Choose Top in the dropdown menu. 
3. Enter Opens internal link in current window in the Title field. (as 
4. Browse the page tree to reach the page you wish to link to and click on the page 

name. (as pictured in figure 26-a) 

 
Figure 26-a 
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Linking to an external URL (another website) 
You can also link to other websites. Be judicious in how many external links you use as 
websites often change which could lead to broken links on your page! 
Once you are editing within a content element, select the text that you want to link your file to 
and click on the TYPO3 Link icon (as pictured in Figure 23). 

1. Click on the External URL tab. 
2. Click the down arrow to open the target menu and choose New window. This will open 

the Web page in a new browser window or tab when a user clicks on the link in the Web 
page. 

3. Type Opens external link in new window in the Title field. 
4. Copy the URL and paste it into the URL field including the http:// or https://. 
5. Click Set Link. 

(as pictured in Figure 27) 

  
Figure 27  

Save and switch to preview mode (see Previewing Pages) to test the link. 
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Linking to an email 
You can also create links to email addresses on your page.  If you provide an email address 
on your department’s pages, you should create a link to that email address. 
Once you are editing within a content element, select the text that you want to link your file to 
and click on the TYPO3 Link icon (as pictured in Figure 23). 

1. Select the Email tab. 
2. Copy and paste the full email address into the window. 
3. Type Opens email program in new window in the Title field. 
4. Click Set Link. (as pictured in Figure 28) 

  
Figure 28  

Save and switch to preview mode (see Previewing Pages) to test the link. 

Accessibility Note: Accessible pages allow individuals using screen 
readers to ‘scan’ the links quickly by using meaningful text that describes 
the link destination. Never use phrases like ‘click here’ since without the 
context of the paragraph, they are ambiguous.  Use link words and 
phrases that can be intuitively organized, for example: ‘Contact us’ as 
opposed to ‘how to contact us.’ 
Tip: If the title on the hyperlink's destination page gives an accurate 
summary of what is on the page, use it for the hyperlink text. For 
example, this hyperlink text matches the title on the destination page: 
Templates and Themes for Office Online. 

Link Titles: In TYPO3, use phrases placed in the title field to alert a user of assistive 
technology of actions occurring with the link: 

• Opens internal link in current window (when linking to another page in your workspace) 
• Opens internal link in new window (when linking to a page in another workspace)  
• Opens external link in new window 
• Opens PDF in new window 
• Opens window for sending email 
• Directs viewer to a section on this page (when linking to a bookmark on the same 

page)   
• Opens video in new window 
• Opens audio player in new window 

  

https://templates.office.com/
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Deleting Documents/Files/Images from your Filelist 
TYPO3 editors have the ability to delete unused document and image files from their 
workspaces. TYPO3 should have currently used documents and images and should not be 
used to archive older documents. 
To delete unused or unwanted files or images. 

1. Go to the Filelist Module. 
2. Check the box before Extended View (if not already selected). 
3. Select the appropriate directory- documents or images (as pictured in Figure 29). 

  
Figure 29  

Remember that the Ref number shows how many times a file or image is linked to within 
TYPO3 (as pictured in Figure 30). 

 
Figure 30  

Format options in the editor 
There are format options available from the menu bar in the editor. You should be sparing 
when using italics, bold and other type features. The Formats drop-down will be useful when 
editing to help replace Buttons and to add PDF and External link icons. The Styles page 
shows an overview of the current MCC web styles.  
When you edit text that has special formatting (such as a Button), you may remove the 
formatting.  No worries, you just need to select the text, and then apply the format after you are 
done editing. 

http://sites.monroecc.edu/web-standards/styles/
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1. To add a Links & Buttons format, you first need to create a link (see TYPO3 Link 
section). 

2. Select the text of the link. 
3. Select Links & Buttons from the Formats drop-down. 
4. Select your button style:  

o Button Primary is outlined in Gold. 
o Button Primary Full is a gold button (text will appear white). 
o Button Secondary is outlined in Grey. 
o Button Secondary Full is a grey button (text will appear white). 

(as pictured in Figure 31) 

  
Figure 31  

A general rule of thumb is to alternate use of primary and secondary buttons. 
1. Create a link. 
2. Select 
3. For document files (should be saved as .pdf), select PDF Link. 
4. For a link to another Website, select External Link. 

(as pictured in Figure 32) 

 
 Figure 32  
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Previewing Pages 
At any time during the editing process you can preview the page to see what your changes 

will look like on the Web by clicking the Save document and View Page icon. This opens a 
new window/tab (as pictured in Figure 33). Be sure to allow all popups from this site! 

 
Figure 33  

Moving the (1) slider bar between Workspace and Live moves the view between the page you 
are currently working on and the page that is live on the Web. 
Clicking on the (2) end icon allows you to select how you want to compare the working and 
live view; either side by side (vertical), or stacked on top of each other (horizontal) (as pictured 
in Figure 34). 
Move back to the other open TYPO3 tab to resume editing. 

 
Figure 34  
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Another way to quickly preview your work; click View in the Web category of the Module Menu 
to open the page in the content area (as pictured in Figure 35). This preview does not give you 
the option to easily compare your changes to the live Web page. 

 
Figure 35  

Moving from Editing to the Next Stage in Workflow 
Once you are satisfied that you are done, you need to move your edited page to the next stage 
in the workflow by clicking ‘Send to stage “Dept approval”’. 

Select the Save and View option  to get the preview to open in a second window. 
Clicking on Discard will roll back any page content changes that are ready to send for 
publishing in the Workspace. Don’t worry if you click it by mistake, a pop up will ask if you 
really want to do that. 
NOTE: Using the green button in this view to send to the next stage in the workflow will mark 
the individual content elements on the page as “Dept Approval” (as pictured in Figure 36). 

 
Figure 36  
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Once ‘Send to stage “Dept Approval”’ is clicked, a pop up box will open. Some email 
recipients may already be listed and checked. Any that are greyed out can’t be changed or 
deleted. 

1. To add additional people to the notification, type the email addresses into the top text 
box, separated by semicolons. 

2. Include a comment in the box below to identify the change you made for your 
publisher. 

3. Click ok to process the action. 
(as pictured in Figure 37) 

  
Figure 37  

Special Note: To limit the number of emails sent when making multiple edits on several 
pages in a short period of time, move the edits to "Dept Approval" state from the Workspace 
module, instead of using the green button in the preview window for each individual page (as 
pictured in Figure 44 below). 

Reviewing Edited Pages and Publishing 
The next eight steps require that you are a department Publisher. Basic Editors do not have 
permissions to move the changes beyond the “Dept Approval” state. 
In the working view of the site start at the landing/top page of the group, then open the 
Workspaces module in the left-hand navigation bar to view all changes to the site, and the 
current state for each change (as pictured in Figure 38). 

 
Figure 38 
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Special Note:  
• If you do not start at the landing page before opening the Workspaces module, you 

won't see all of the changes. 

• Click on the clear page cache icon   in the upper right corner of the page 
module, when minor changes are made, to make sure you can see the changes. 

 
If you have access to multiple workspaces, you will see more than one tab, select the 
appropriate tab. Publishers will see all edited pages (as pictured in Figure 39). 

 
Figure 39  

By moving the cursor into the end column, you can choose action options related to the 
content element or page. The last icon will open a change history for that item (as pictured in 
Figure 40). 

  
Figure 40  

The green highlighted text indicates the change that was made to the page. You can also see 
the date and time the change was made, and who made it (as pictured in Figure 41). 

  
Figure 41  
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The legend at the bottom of the Workspaces module gives the color-coded key for the kinds 
of changes displayed in the record history. These include edited, moved, created, hidden and 
deleted (as pictured in Figure 42). 

  
Figure 42 

You can also choose the option to move forward or back in the workflow cycle until you have 
selected Send to Ready to Publish.  Once an item is in Ready to Publish status (as pictured in 
Figure 43), it will get a final review by the Technology Services Web Team before it is 
published to the live website.*  If at this point, you need to make a change, a web team 
member can return it to editing status for you. 

  
Figure 43  
Actions can also be selected at the bottom of the page. After selecting the pages, select the 
action from the dropdown menu at the bottom of the page (as pictured in Figure 44).  

  
Figure 44  

*Final Review 
The College is committed to the accessibility of our website as part of our open access mission 
and our service to our community. To further this commitment, the manner in which information 
is posted on the website has been changed to centralize the publishing of content, allowing 
trained members of the Technology Services Web Team to be the posters of new website 
material. While TYPO3 liaisons will retain responsibility for the content of their web pages and 
will still be expected to follow the ADA Compliance Standards and MCC Standards for which 
they have been trained, changes to the website will be published to the live website after 
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careful review for ADA compliance, functionality and style conformity by the Technology 
Services Web Team. 

Publishing Schedule 
Publishing will occur Mondays, Wednesdays and Fridays, excluding days when the 
College is closed. Normal operations will commence on the next scheduled review date. Any 
changes made after noon are not guaranteed to be moved live until the next publishing 
day. Please plan your changes in accordance with the publishing schedule. 
Urgent request for uploads can be made on a limited basis. To request an urgent change, 
a technology request ticket must be submitted indicating the reason for the urgency and 
explanation of what changes were made. Urgent requests for publishing will only take place 
during normal business hours and are not guaranteed. There will be a few exceptions for 
publishing changes that will be published to the live website outside of schedule: 

• Broken Links 
• Cancellations 
• Date Changes 
• Legal Requirements 
• Misinformation 

Getting Help 
The current version of training material can be found at M:\Offices\Shared\TYPO3 Training 
Materials. 
Visual examples of pages, headlines, buttons and more can be found at 
http://www.monroecc.edu/typo3-training/examples/. 
To get help with TYPO3 technical problems, log on to MyMCC and go to the Tech tab. Under 
Technology Service Support & Requests, click Create or View Technology Support 
Requests. Under Request Help With… Select Web Site. 

1. In the Description give a brief description of the TYPO3 issue. 
2. Be sure to include the URL of the page (copy it from the address bar of your browser). 
3. Add a date required if appropriate, complete the rest of the request as necessary and 

click submit. 
Updates to the Faculty & Staff directory listings 
Note:  If you need to have the Faculty & Staff page updated, this information comes from the 
College Directory.  Log on to MyMCC and go to the Tech tab. Under Technology Service 
Support & Requests, click Create or View Technology Support Requests. Under Request 
Help With … Select Telephone & Directory Services – then select Directory listings and fill in 
the form. 

http://www.monroecc.edu/typo3-training/examples/
https://my.monroecc.edu/
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